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NO GENERAL MEETINGS * JULY AND AUGUST 2008

A New Class Photoshop Elements 6
ADOBE

Photnshop

On Thursday, July 17, 1-3 p.m., at the Mac Learning Center,
Anne Clark will begin a "Photoshop Elements 6" class. This
class will demonstrate, and provide hands-on practice of, new
tools in Photoshop Elements 6. On July 17, the topics will be
the "Quick Selection" tool and "Fixing Group Shots."

= On Wednesday, July 9. 1-3 p.m,
Pa g es Shell Weinberg will be giving his new class,

“Fundamentals of Pages” by Shell Weinberg”’ .
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Board Roster 2008...

Charles Clark, President........ccoocuvvveiieiieieeiieiiieeeeeeenieen. 837- 6080
Email: cclark@comline.com

Willem Vermolen, Vice President/Supervisor ................... 472-5002
Email: Wimolen@mac.com

Anne Clark, Secretary/Web Manager/Instructor............... 837-6080
Email: aclark@comline.com

John Hansen, Treasurer/Membership...........cccccceceneennee. 830-5260
Email: jhansen@comline.com

Shell Weinberg, Supervisor/Instructor.............ccecevveruennee. 581-8481
Email: shell@comline.com

Gladys Greene, Publication/Supervisor...........c..cccceuenenee. 768-7700
Email: greenefg77@comline.com

Murray Massin, Supervisor/Instructor..........c.ecceeeenenens 837-0878
Email: emngee@comline.com

Ed Egan, Past President .........cccccocevireninenieiceeieeee 859-1938
Email: eegan@fea.net

Bob Payne, SUPErvisor..........ceverieneiienieeieieeieseeeiene 472-0356
Email: bobpayne@aol.com

Fern Lerner, TLC COMMULLEE.......ccvvvveeeveeriieeeeeeieeeeeeenne 951-8494
Email: falerner33@fea.net

Carol Peterson, Membership Assistant............ccceeueeeenene 586-2720
Email: carolpetersonl @mac.com

Faye Pearl, SUPEIViSOr .......ccccoevuerienieiiieieininereeenieneens 470-9409
Email: fayepearl@comline.com

Ruth Williams, Librarian...............ccccceeeeeieeeeiieeeieceeee 598-2953
Email: ruthe@comline.com

Ed Fuller, Mailing........cccoeevenienieieieieineneneeeseseeseenenne 770-9211

Email jeffl2@fea.net

Mac Board Associates...

Louise Dawson, Apple Ambassador.........c..c.ccceevennenee. Email only
Email: yesyoucan@mac.com

Michael Moore, Supervisor/Instructor...........c.ceevveereenne 770-9796
Email: mikes59@myway.com...

Audrey Glenn, Telephone Tree.......c..ccccovevveieirencnennenn. 588-0656

Email: amglenn@webtv.net

Mac L. C. Supervisors . . .

Craig Hoyt, SUPETVISOT....cccueeviiiriieiieniieniieeieesiie e 859-8007
Email: craig@aztech4mac.com

Louise Doslu, SUPETviSOr........cocueerieriienienieeniieeieenieens 855-9010
Email: loeydos@Gmail.com

Dennis McGovern, SUPETrVISOTL.......ccc.eevveerieerieenveenieennes 462-3681
Email: dmcgovern@mac.com

Ned Read, Assistant SUPEIVISOT.......ccevveerieerveerieenenennne 457-9190
Email: nedread@comline.com

Metche Franke, Assistant SUPETVISOT........cceeverrveenerennen. 462-9316
Email: metche@comline.com

Board Meetings.......... Tuesday afternoon, 1:15 p.m.,
following the Thursday General Meeting each month.

Important Information...
Mac Learning Center Phone.........c..cccceeeevienienncne. 268-2263
The Mac Club Web Site.................... www.TheMacClub.org

Anne Clark, Web Manager ...... Email: aclark@comline.com
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President’s Message...

General meetings. There will be no
General meetings in July and August.
However, the Learning Center will
be staffed with no change in hours,
and most of the classes will continue.
Check the newsletter and the club web site for more
details: <www.themacclub.org/LearningCenter.html>.

Mac OS X 10.5.3 update. I had one problem with
updating an old flat-panel iMac to the latest OS X
update. The download and installation proceeded
without problems. My problem began when the iMac
restarted. The screen would not proceed from the
revolving ‘gear wheel’ officially known as the Inde-
terminate Progress Indicator. Many troubleshooting
tips are available on the web to solve problems. One
tip for software installations is to disconnect the USB
or FireWire cables to your printer and/or external
hard drive. My malcontent iMac was connected to a
very complicated HP all-in-one printer. I disconnected
the printer cable and proceeded to restart. The iMac
completed the install process and displayed a normal
Finder window. Finally!

Oddball email problem. A member complained
that he could not receive email and requested I take a
look at the problem. I opened Mail Preferences... and
reviewed the Account Information data. All was well.
I then opened the Advanced tab. There I found the
checkbox was not checked for ‘Remove copy from
server after retrieving a message.” What this meant
was that all incoming email collected by his ISP, say
West Coast Internet, would remain on their mail
server until you remove it or ask them to remove it.
If you do not remove the old mail, eventually the
email storage space allocated to your account fills up.
In this case, the mail server was full and could not
function. I corrected the situation by adding the miss-
ing check mark and clicking the ‘Remove know’
button. Since there were over three megabytes of data
on the mail server, the erasure took some time.

West Coast Internet has pleaded with me that you

set your Advanced with the ‘Remove copy...” pop-up
button to read ‘Right away.” No harm in that. All your
email will be transferred to your Mac, and the mail
server will have space to collect new mail.

Cheers .... Charles



No Programs in July and August 2000

A Word of Caution: Faye Pearl....

| don’t know if this applies to PC users; but | can attest to the fact, after having had multiple
problems, that the webmail West Coast Internet is now using is NOT reliable for Macintosh
users.

A couple of months ago | was out of town. In going to the mail.comline site several
problems occurred. One was that | was unable to navigate the site. The second very big
issue was that only junk, advertisement, and group mail came through; no personal mail.
The personal mail was forever lost.

| had many long distance phone calls with West Coast Internet. Their overall attitude was
that | was at fault, the Macintosh computer | was using (my sister’s) was out of date, they
tested it at their end and everything was working fine.

On my return home | complained to whoever would listen. A support technician came to my
home to check the problem. He verified that webmail was not working properly; that | could

not navigate the site. He asked me to switch from Safari to Firefox. | did that and again he

witnessed that the program was not responding.

Very recently | was again out of town. My son told me that he sent me an email which was

returned to him as “undeliverable”. Again | started with the long distance calls and email to
determine why this occurred. My son re-sent the message to me both to my gmail account
and to my comline account. The gmail delivered the email; the comline again returned it to

him as undeliverable.

| informed Paul, with West Coast Internet, of this. | got a song and dance routine. In the
end his advice to me, via email, was that if GMail was more reliable--I should use it. They
were, overall, quite satisfied with their program.

| have no idea what emails | have not received; and it’s disquieting. It is also very
uncomfortable for me to know that West Coast Internet does not have a reliable responsive
webmail program as a priority.

The Door Prize winners at the

General Meeting, June 12, 2008 ‘\FE ALINGS

Michael Moore a

Ted Mille Published 11 times yearly by the Laguna Woods
Carol Stephenson Village Macintosh Club in Laguna Woods, CA.
Diki Sields Editor/Publisher Gladys Greene
Gladys Greene Proofing Fern Lerner
Robert. Iehl Labels Carol Peterson

Ted Mille Ed Fuller Mailing
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“Anne's Corner"”
Editing Word Files - Without Word

In OS X 10.5 "Leopard,” it's easy to work with Microsoft Word files
on your Mac, even if you don't have Microsoft Word installed on your
computer.

TextEdit, your Mac's built-in word processing program, can open MS
Word files (which are often distinguished by a “.doc” or “.docx" suf-
fix). Simply double-click the document icon. It will automatically open in
TextEdit if that's the only word-processing program on your computer.
If you have several, you can specify which program to use by Control-
clicking on the file icon (or right-clicking if you have a two-button
mouse) and selecting your desired program.

Now you can edit the file just like any other document. However, if you
want to share your file with MS Word users, be sure to save your work
in Word format. Here's how:

1. From the File menu, choose Save AsS or type Command-Shift-s.

2. Click-hold on the File Format tab and choose one of the Word for-
mats.

3. Click Save.

If you own iWork '08, you can use similar techniques in Pages, Apple's

advanced word processor. But instead of using the Save AsS command,

select Export from the File menu. Choose the Word option and press
Next.

This Apple Pro tip is published at http://www.apple.com/pro/tips/word_
files.html and will be reviewed in the next Email/Internet class.

Enjoy!
Anne Clark
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My Autobiography , Board Membership.....

| am Carol Peterson, happy resident of Laguna Woods since 2000. | was born and raised in East Chicago, Indiana,
where | met and married my husband Frank.

We had two children and | was fortunate to be able to stay home with them. When they were teenagers, | decided to
move up to the 20™ century, learn how to work computers and hopefully make a buck or two. After taking classes at
the local university | bought my very first computer, a Televideo with a whopping 64 megabytes of disk space.

The good news..... | learned how to work the darn thing and started doing word processing and data entry at home. |
then saw an ad in the paper for a court reporter transcriber. Didn’t know what that was, but | got the job anyway.
My reporter would stroke the testimony in court, transfer it to a floppy disk, and I'd make a finished transcript from it.

The bad news..... | ended up with bad carpel tunnel syndrome after about six years, and had two surgeries. Doc said
“No more typing all day for you”.

The good news..... | love aquatic exercise, so | studied, took classes and became certified as an instructor and
personal trainer.

The bad news ..... aquatic exercise is great for the people in the water, but hard on the instructor running around on
the deck like a crazy person. | ended up with a torn Achilles tendon. End of that.

| guess I'm still trying to figure out what | want to be when | grow up, but I'm sure having fun in the process.
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Peachpit @

User Group Program Member

Louise Dawson’s Review:
PEACHPIT BOOKS.

Be sure to check out <peachpit.com> for some very helpful books. Use the code UE-
23 AA-PEUF at checkout to receive a 30% discount. Here are just a few or our favorites:

Robin Williams’ “Cool Mac Apps: Twelve Apps for Enhanced Creativity and Productivity,
3rd Edition.”

Scott Kelby’s “The Photoshop Elements 6 Book for Digital Photographers.”

“Microsoft Office 2008 for Macintosh: Visual QuickStart Guide” by Steve Schwartz.

But my favorite book right now is “The Mac OS X Leopard Book. How To Do The
Things You Want to Do On Your Mac.”

The author, Scott Kelby, is “the world’s #1 best-selling computer book author” according
to the cover and I can see why. What a wonderful little book. It serves as a quick resource
manual with a page to cover probably every aspect of using OSX Leopard and the applica-
tions you may own.

Scott is a fine author with great knowlege and the ability to educate others with expertise
and humor. Each topic has its own page with screenshots, easy to follow directions and an
occasional special tip. For example, on page 128, you will find one long paragraph tell-
ing you exactly how to find music at the iTunes store. On page 129 is a smaller paragraph
explaining how to buy the music once you find it. The next few pages cover other aspects
of iTunes. Then we move on to other music subjects such as burning an audio CD, adding
music to your creations, and using speakers with your Mac.

You will find instructions regarding the use and customizing of the computer, common ap-
plications such as iPhoto, and a few tricks you may have been hesitant to try or didn’t even
know existed such as video conferencing. There is plenty of advice for handling every
aspect of mail and web browsing including how to deal with SPAM and Parental Controls.
Even if you think you know all you need to know, there is enough in this 246 page book to
inspire you and take away your fear of trying new things.

At a very reasonable price of $24.99, you can find this fun and excellent book at <Peachpit.
com>. Use the code UE-23AA-PEUF at checkout for a 30% saving on any Peachpit book.
Books make great gifts for the beginner, the challenged, or those who want o raise their
game. Peachpit covers many areas including DVD production, Web Design and Photogra-
phy so there is something for everyone, even those who don’t own a Mac.
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Macintosh Learning Center
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Time to bite the bullet. .. this is Pages

Without further ado [ have switched, from
AppleWorks word processing, to using Pages
to provduce the column vou are now reading.

I don't believe you will notice any particular
difference in what you are secing. The fonts,
style, and layout appear to be identical 1o
earlier Mac LC columns. It is creating the
document that has challenging differences.

Those of you who are loyal readers of this
column are aware that the previows three
columns have been devoted to explaining
some areas of confusion when one starts
using the word processing program Papes.

Today we actually show you the results when
creating a new two column word processing
document using Puges exclusively. I must
confess, however, the first
five lines were copied from
an earlier AW doc and then
pasted into this document.
Everything else is new, fresh
and Pages produced,

S0, let’s write a bit about the challenzing
differences mentioned earier. For example.,
making the graphic of the Pages icon fit into
the above space was a hassle because of the
annoving factory defaulis object wrap and
text fit. | finallv found the Send Ohject to
Background command in Arrange menu,

I also learned that control of the wrapping of
text from column one to column two required
that 1 go to the Insert menu, and then select
Column Break to get the break 1 wanted.

Some other general Pages information.. .
if you would like o insert the date and/or
time into a document you should drop

the Insert menn and select the Date & Time
command. The default shows the date only in
vour document, Next, vou must double click
on that date line to open a dialog which offers
choose Date Format, and there is where vou
will find a pop up menu showing time selting
options for your selection.

Preset defaults ooy ser selections) -

live work area s 6 12" x 10",

based on 8 172" x 11" paper size

one column
font is Helvetica Regular
size is 12 point
alignment is flush left, ragged right
text color is black
background color is white
line spacing is 1 line
tabs are set every 1/2"

Above settings can be changed by visiting:
Toolbar (at top of the window)
Ias fexibility, can add fcons or remove
Format bar {beneath the Toolbar
changes when working with graphics
Inspector (icon is on the Toolbar)
hays abour 165 different sering options

Fc margins... open the Inspector, click on
first button {Document Inspectory. Then be
sure Document button is highlighted. See
Docoment Margins section displaving the
four margins, Left, Right, Top, Bottom. You
can make a change here and watch the change
occur immediately in vour open document.

R word count. number of pages, how many
lines in the document, etc. Thiz information is
available when you open the Inspector. Click
o first button (Dacument Inspector), then
clhick on Imfo button.

Should you want to include an audio file, or a
few photos, or even a movie, in vour word
processing doc. .. click on the Media icon on
the Toolbar and make your selection by
dragging the file icon into your document.
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@ FeaLings

Laguna Woods Village Macintosh Club
Laguna Woods, CA

Gladys Greene
5468 Paseo Del Lago E, Unit B
Laguna Woods, CA 92637-7322
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®E® calendar = July & Aug 2008

INDEPENDENCE DAY jL.C. CLOSED)  Friday, July 4

= g-Mail # Internet CLASS (Anne Clark) Thursday, July 1 & Awg 7 1:00

Comp BEGINNERS SESSION (Murray Massin) Friday, Aung 8 only

1:00

*| * Fundamemntals of Pages CLASS (5. Wenberg) Wednesday, July ? only 1:00

= Mac for Dummies CLASE (Shell Weinberg) Wednesday, Aug 13

1:00

BOARD Meeting in Spruce Room (Adm. Bldg.) Tuesday, July 15 & Awp 19 1:15

*| = Photoshop Elements & CLASS (Anme Clarkl  Thursday, July 17
= Digital Photo CLASS (Anne Clark) Thursday, Aug 21

1:00
1:00

iMovie O & A (Michael Moore) Friday, July 15 & Aug 20  1:00

ALL CLASSES [+) ARE DROP-IN ..... with a request for a $2 donatlon

w dr mmmam Llnwdee fhesmelbh Tessdme g =Ml = e

hl.lll.llll.l.llh l_-l.!.l.l.l‘!lil.:l [—FEI.I.I.I.I.I.IIE 'l.-:rlI.El. L= w“.l 'H.I.ll.l.ll.l.'l.l_'r lllllﬂ.lE.-. I.J.II.I.'I.I_T

-
LECEJ I 1 R

i
ur

EXCEPT when Classes are given it will be closed, and om July 4 (Holiday)
Schedule subject to chamge, see http://www.themacclub.org for the latest information

Mac Learning Center telephone number 268-2263
*}] NEW CLASS




